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Executive Summary 

Accumulation of sediment and the racking of debris in reservoirs limits the available water 
supply for municipalities and irrigators, reduces flood control space for protection of 
downstream communities, reduces recreational capabilities, and eventually reduces the economic 
and environmental viability of the project. The arrival of sediment deposits near the dam can 
compromise the functionality and safe operation of dam facilities. Excessive sediment deposits 
against a dam can become a dam safety issue and an expensive burden to the American public to 
address in a reactive manner. Unmanaged reservoir sedimentation can eventually result in 
resource loss. 

Reservoir sedimentation impacts all Reclamation facilities; regular bathymetric surveys are 
necessary to estimate rate of sediment accumulation.  Surveys require expensive software, 
several days of fieldwork, and extensive, time-consuming post-processing procedures.  Due to 
limited resources and time, approximately one-third of Reclamation reservoirs have been re-
surveyed since their construction. This is problematic as the extent of the accumulated sediment 
(and other materials) are unknown. Bathymetric surveys allow Reclamation to monitor 
sedimentation, predict future accumulation rates, and potentially implement mitigation measures 
before sedimentation disrupts facility operations. The resources required to post-process multi-
beam bathymetric data limits the number of surveys that can be conducted and evaluated. 
Furthermore, there is a backlog of reservoir surveys needing to be post-processed. Development 
of the proposed tool would decrease the resources required for each survey; thus increasing the 
number of reservoir surveys conducted, which would improve our knowledge of sediment 
accumulation for a given reservoir/region. 

The current methodology requires an expensive license and requires two staff days for every day 
in the field. The HYSWEEP program allows the user to post-process the data utilizing a few 
automatic corrections and manually eliminating outliers. The first editing stage allows the user to 
correct for heave-pitch-roll, tide-and draft, and sound velocity. This stage is already automated 
within the HYSWEEP Program. The second step involves a swath-by-swath editing feature, 
which requires the user to manually delete outliers by viewing the data both longitudinally and 
cross-sections. This step is time-consuming and Reclamation would benefit by developing a tool 
to automate the second step of post-processing.  Automating and streamlining this process would 
decrease the cost of each reservoir survey, allowing Reclamation to survey more of its projects 
for the same price. 
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Background 
HYPACK is a commercial software package that provides surveyors with tools needed to design 
a survey, collect data, process results, and generate final products.  Reclamation’s Sedimentation 
and River Hydraulics (SRH) Group uses HYPACK software to drive the multibeam acoustic 
echosounder used in hydrographic surveying of reservoirs.  A complementary set of HYPACK 
software tools are used to process the collected data into a finished result.  On June 11th, 2018, 
Reclamation engineers consulted in person with Joe Burnett, Technical Consultant for the 
company that develops HYPACK software.  The meeting was productive in covering specifics 
related to the SRH Group hardware implementation as well as delving into strategies for efficient 
processing of data.  The notes from that meeting, which include descriptions of pointed 
uncertainties and corresponding responses from Joe Burnett, are included in Appendix A.  Joe 
also provided an informal guide (Appendix B) to editing survey data with MBMAX64, a 
packaged collection of 64-bit multibeam editing tools.   

The US Army Corps of Engineers (USACE) performs an annual sediment flushing exercise of 
the main outlet gates at Cherry Creek Reservoir in Denver, CO.  Completed in 1950, Cherry 
Creek Dam and Reservoir are operated by the USACE to provide flood protection to the Denver 
Region from floodwaters.  The purpose of the flushing exercise is to scour sediment from the 
area immediately upstream of the radial gates, thereby preventing detrimental buildup and 
maintaining operability.  In 2017 and 2018, USACE, USGS, and Bureau of Reclamation (BOR) 
crews collected hydraulic, sediment, and bathymetric data necessary to verify gate discharge 
curves, develop sediment discharge relationships, and measure the volume of sediment removed 
from the reservoir during the annual flush.   The program of study involved conducting a pre and 
post-flush bathymetric survey of the reservoir bottom in the vicinity of the damn outlet works.  
Processing the survey data provided an opportunity to explore various editing strategies, 
including approaches recommended by Joe Burnett from HYPACK.   

Methods 
Specifying correct hardware configuration and setup of the project within HYPACK software is 
important prior to entering the editing phase.  A visual guide of the progression through the setup 
windows is compiled and presented in Appendix C.   

After the Read Parameters sections are navigated in MBMAX64, the user can define a border in 
the survey (if not done already), and choose File > Clip Survey to Border File.  The user can then 
employ the automated filters (Ctrl + F) to remove much of the bad data.  The user can then 
proceed to coarse filtering of the whole color model in the main MBMAX64 edit window.  
Finally, Stage 2 filtering can be implemented using the Sweep windows.   

Several instructive online video tutorials have been produced by HYPACK and are available on 
the web for viewing.   

Applying Automated Filters Tutorial: 
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https://www.youtube.com/watch?v=Aj5LgzEzJbE 

Editing in Survey Window: 

https://www.youtube.com/watch?v=2hVPsE7BXb4 

The Survey window within the MBMAX64 editor provides several useful tools for gross 
processing of data.  A collection of statistical filters provide semi-automated methods for 
correction of deviatory data points.  Further refinement can be performed by manual editing via 
visual representations of the data, either as a three-dimensional colored rendering of the entire 
dataset or through systematically selecting subsets of beam sweeps.  Although the latter approach 
provides the user with the most control over how points are identified and flagged for removal, 
the process is exceptionally time consuming.  In comparing strategies for editing datasets, it was 
found that extensive use of the semi-automated statistical filters significantly reduced the volume 
of editing to be performed through manual editing.  Because the statistical filters are effective 
and quick to apply, maximizing use of the filters tended to significantly reduce the overall time 
spent in producing a final result.   

The disadvantage of using semi-automated statistical filters is that any data points satisfying the 
filter criteria will be removed, regardless of whether bathymetry is accurately being represented.  
Large quantities of data, valid or not, are likely to be removed through use of such filters.  
However, it was observed that even with aggressive use of filters to coarsely remove data, the 
total percentage of points removed from the full dataset tends to be in the single digits – in other 
words, even if valid data is being removed, the result is unlikely to significantly affect the 
resolution of actual ground features.  Thus, it is considered advisable for practitioners to make 
liberal use of the available filtering tools prior to conducting any manual editing of data, as it will 
likely dramatically reduce the overall time spent editing.   

It should further be emphasized that the process of editing represents a practitioner’s 
interpretation of the data, not an absolute correction of the data.  Thus some variability in the end 
result is inherent and unavoidable.  The significant subjectivity of interpretation of the data also 
means that streamlining the process of the interpretation is inherently fraught with challenge.  
Without clear metrics on which to build a set of analytical criteria for automatic classification of 
data, the onus is on the practitioner to base interpretation on their experience and a priori 
knowledge through an inherently “hands on” approach.       

Recommendations for Next Steps 
For the purposes of building consistency and efficiency of processing among multiple users of 
the HYPACK software, a set of procedures are being set forth as part of a best practices 
document.  The lessons learned from this project will be included within the written guidelines.  
These guidelines will be available for consumption by any Reclamation personnel that is a 
practitioner of multibeam reservoir surveying.  The goals of establishing guidelines are to 
improve workflow processes by: 

https://www.youtube.com/watch?v=Aj5LgzEzJbE
https://www.youtube.com/watch?v=2hVPsE7BXb4


 

 

 

• Promoting the use of consistent and repeatable procedures for collection and analysis of 
data in support of Reclamation projects 

• Optimizing value for clients by decreasing costs and increasing quality of deliverable 
products 

As workflow processes are continually improved through enhancements in technology, increased 
understanding of hydraulic and sediment processes, and refinements in the needs of 
Reclamation’s clients, the stated best practices will evolve in order to continually meet the goals 
identified above.   
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HYPACK Meeting with Joe 
Burnett, June, 2017 

 



HYPACK Questions and Topics 
Joe Burnett: June 11 & 15, 2017 

Multibeam – MB1 

Set Up 

• Geodetic Parameters Window 
o Does Elevation Mode have to be unchecked to view and edit depths rather than 

negative elevations? 
o Strictly for display purposes. Has no effect on RAW data 
o In Editor, invert tides or elevation mode will invert elevations and depths 
o Final elevation in display window should be a positive bottom elevation 
o Under RTK Tide method, does selection of N and K source matter if using depths rather 

than elevations? Joe says no 
o N indicates GEIOD 2012, k is for something arbitrary to get to a local datum, recorded in 

the raw files and will be applied to the RTK values. Use “Orthometric Height Correction” 
for ‘k’ from user 

o ALWAYS check “Record Raw Messages” in GPS NMEA of Read Parameters 
o Leave “N from geoid model, k from user value” button checked 

 If we lose RTK, waves can effect elevation values, the heave-tide function can 
correct short times and wipe out WSE values during lost GPS and interpolate 
between good files. Be careful in depth mode when using fixed WSE, waves can 
cause error in depth measurement, especially during roll when the array moves 
laterally. 

o Most people use 219 kHz for MB1, we use 200 usually. 219 is the highest Image 
software will allow. 

o Deeper water needs a longer pulse width. Higher pulse width provides better resolution. 
Depth values can only resolve depth to the length of the pulse width. 

o Need to understand the error – especially with deeper depths 
o At 400’ depth, the nadir beam is 28’ diameter spot size (4 degrees each beam) 

 Think about this with raster resolution, 5’ x 5’ reasonable? Maybe 10’ x 10’ or 
greater 

 Joe says cut AT LEAST 5 degrees from the edges on a flat bottom 
 At bank lines it does ok on the steep bank side, but you probably need to cut 

more on the lake side. 
o Soft bottoms absorb the signal more than firmer bottoms, e.g. Altus 
o Auto Adjust Pulse Width and Range should maybe not be used 
o Equdistant for flat bottom 
o Equiangular for relief 

• What do the different .ini files do? 
o Which .ini file stores the hardware settings? 
o Which .ini file stores the read parameters information? 
o Which .ini file stores the patch test results? Stored in Hysweep.ini file at the top of the 

file 



 Hypack – pos. device (passed to Hysweep), written to RAW file - Survey32.ini 
 Hysweep – Hypack nav, motion, HDG, MB, written to HSX file - Hysweep.ini 
 HYSWEEP 64-bit Editor – Patch test values and offsets – Boat.ini (only used in 

editor)  

 

• Multibeam calibration/patch test – Should we be using the transducer as the boat tracking 
point? Yes 

o Hysweep offsets should be the same as the MB1 
• Joe suggests an Odem MB1 Template Project, do this on the boat for those specific monitors 
• Monitor specs – look for the NIT rating, most in 200-250 for indoor, daylight bright is 500 or 

higher for daylight readable, 800 to 1000 is better but harder to find and more expensive 
• Joe recommends the Honda 2000 generator instead of current battery system 
• Should we limit recording rate in Survey Connect tab? If yes, for what device (GPS-NMEA or 

HYSWEEP) do we enter that limit? (Joe referred to this as a “motion data output rate” and 
recommended 50Hz instead of 100Hz. Dependent on baud rate, when we change that this will 
update 

 Joe says there’s no meaningful sensitivity above 10 Hz 
o What are the benefits of collecting/recording at a slower rate? None that Joe knows of, 

it’s just not typically necessary to collect faster than 50 Hz 
• Review the physical set up of our survey vessel – Friday 

o Do you have any suggestions on how we can improve efficiency or accuracy? 
o Are there any fatal flaws with our set up (brackets, GPS antennas, boat reference point, 

etc.)? 

Collection 

• Are there known issues connecting to GPS in HYPACK 2018? (Rob and Caroline’s problem on El 
Vado) – Coordinates for background map were at 0,0 (boat was at origin) 

• Latency issue – latency varies within and between files (Bighorn examples) 
o We’re collecting at 5 Hz, Joe says that’s fine 
o Ping rate is dependent on depth, at 5 Hz you will get 5 positions in 1 second, think about 

how many pings per second we’re getting. 
o Stage 1 editor loads all positions and pings 
o Stage 2 merges tags based on times. 

 Look at first POS time to first RMB 
o GYR 1 recommend 10 Hz in Vector PC, update HDT to 10 Hz 
o Our HCP (heave, pitch, roll) rate is almost 100 Hz. This update frequency is based on the 

baud rate. 9600 baud = 33 Hz, 19200 baud = 66 Hz, 38400 baud = 132 Hz 
o RMB 1 time is when the RTA received the generated ping 
o Each RMB 1 ping needs a POS time before and after the RMB ping so that Hypack can 

interpolate between two POS values 
o In deeper water our latency is likely to be outside the 0.2 ‘requirement’ we’re looking 

for. As long as we’re within a second we’re ok. 
o If latency is many seconds adjust to the POS that happened later, not prior 

 Then Joe said to look at POS, GYR, HCP times that match and adjust RMB to 
these values 



o Latency is always subtracted 
• Depth filtering in Image software? Was it related to the water quality (turbidity/water clarity) at 

Altus? 
• Maybe collect sound velocity profiles at multiple times of the day to account for temperature 

changes at the surface 
• Files are named/time tagged by the PC time 
• Multibeam data typically collected parallel to contour lines 

Post-Processing - Friday 

• Tips for streamlining multibeam processing 
• HYPACK filters in HYSWEEP editor 

o Overview of what they all do 
o Which ones does he recommend? 
o Which ones are most useful for our work and desired level of accuracy? 

• Other filters 
• Can you create a matrix for processing data in a specific area even if you did not collect the data 

in matrix mode? Cloud pop up or create border and clip to border 
• How do you process data in depth mode that was collected in elevation mode? 
• How do you set a target/mark a point of interest in the editor? F5 at cursor location 
• When I open the editor in HYPACK 2018 on my desktop, it tell me it’s in “Demo Mode.” Is that a 

common error? 
• Can you apply different latencies to each line file in a log file? Yes, but this issue has been Taken 

care of with latency discussion. If there are files with different latencies and you create an HS2X 
file leave the latency there as 0. 

o When you import them into the editor together (after editing each individually), which 
latency is applied? 

o When you import them together (after editing each individually), should latency be set 
to zero in the Read Parameters window? 

• Single Sweep window is under the More Mindows 
• SVP Adjust window under Tools pulldown menu allows you to adjust sound velocity to flatten 

curls on outer beams 
• Basic, GPS, Sweep filters work in this order 

o Individual file 
o Individual ping 
o Individual beams 

• Matrix and Search Only 
o Matrix filter using Median, Above, Below, and 2 Sigma Limit 

• Automatic filters designed to remove obviously bad points 
• Median filter most appropriate for flat areas 
• Clipping 

o Create border file in shell – Preparation->Editors->Boarder Editor 
o In Editor – File -> Clip Survey to Boarder File 

• Even flagged for deletion points still exist in HS2X files 
o Points only deleted when save out as XYZ format 

• Read Parameters window 
o Survey tab 



 Perform Memory Test 
 Never use Auto Stage Two 
 Elevation/Depth mode is the only parameter that can’t be changed once .log file 

loaded into Editor 

ADCP – M9 

Set Up 

• Calibration of M9 compass and depths in HYPACK 
o Is the compass calibration performed in HYPACK or the SonTek utilities program? 
o Can we use our GPS heading system instead of the M9 compass in HYPACK? 
o Does HYPACK automatically incorporate CastAway readings during data collection or 

processing? 

Collection 

• Tips 
o M9 orientation 

 22.5o rotation 
 Perhaps use Hemisphere’s heading system to eliminate  

o Connecting M9 to laptop 
 GPS through serial cable to laptop directly? 
 Use of USB to serial converter? 

• Are flow velocity measurements in HYPACK reliable? Only for a stable/non-moving bed? 

Post-Processing 

• Currently, each M9 beam has to be processed separately using the single beam editor in 
HYPACK. Are there plans to eventually be able to process the M9 beams simultaneously using 
the HYSWEEP (multibeam) editor? 

General 

• What’s new in HYPACK 2018? 
 
Joe recommends at least 8 GB RAM, suggests 16 GB. Consistent with what another HYPACK trainer 
recommended (16 GB) in 2016. The new field laptop we ordered will come with 16GB and can be 
expanded to 32GB. 



 

 

Joe Burnett’s Multibeam Editor 
Guide for MBMAX64 

  



Multibeam Editor Guide for MBMAX64 

 

For almost 20 years, I have been collecting and processing Multibeam data, and have done my best to 

find the ‘best way’ to process all of the billions of data points that I have collected.  By the  “best way”, I 

mean the method that is the simplest, easiest, quickest way that will produce the most accurate, 

cleanest, and complete final data set. 

When I perform a Multibeam Training Course, and reach the ‘Editing’ portion of it, I always explain to the 

attendees, that Multibeam Editing, is, in reality, the operation of performing ‘data interpretation’.  If I 

were to provide everyone in the Course with the same RAW Multibeam data set, and ask each attendee 

to ‘edit’ the data, it would be an extremely rare coincidence that any two or more of the attendees would 

produce exactly the same final XYZ data set.  This is due to the fact that each attendee would look at the 

data points, from their previous experience and knowledge, and use their own ‘interpretation’ of which 

points are ‘bad’ and which points are ‘good’. 

With the introduction of HYPACK’s MBMAX64 Multibeam Editor, just a little over 2 years ago, multibeam 

processing has made significant leaps and bounds towards making this a much easier and visually 

understandable process. 

The main focus and purpose of this “Guide” is to provide you with a good fundamental approach to 

processing multibeam data.  I have set it up in an Outline, step-by-side walk-thru of how to ‘possibly’ use 

HYPACK’s MBMAX64 Multibeam Editor.  It will NOT go over EVERY aspect of the MBMAX64 Editor.  From 

this Guide, I hope that you will be able to modify, adapt, and expand on its premise, and allow you to 

create a Guide of your own. 

In the Outline,  “The Prep Work”  walks thru the loading of the data, the selection of corrections and 

devices, the verification of the offsets, the verification of the calibration values, and how some specific  

devices’ data will be applied to the soundings.  Continuing into Stage 1, each device’s time sequential data 

is verified and modified for ALL of the currently loaded files. 

In  “The Heart of the Beast” Section, Filters will be selected and applied to individual files, groups of files, 

and/or ALL files.  Here is where your experience and knowledge of Multibeam surveying and processing 

will come into play.  After the Filters have been applied, the Manual Editing will clean up the remaining 

‘spikes’ and ‘bad’ data points. 

When you reach “The Finish Line”, you will be ready to Save all of your hard work into the predefined 

outputs from your Scope of Work. 

Again, this is just the Outline.  I am working on a detailed version, with screen captures and in-depth 

explanations and reasoning of all the steps contained within the Outline.  Until the detailed version is 

ready, you can get most of the details from the  “MBMAX64”  Powerpoint on our 2014 and 2015 Training 

DVDs. 

 

 



Processing Outline 

 

 

 

1    Open MBMAX64 

2    Configure Settings 

Edit > Settings… 

 

 

 

 

 

 

3    Load Survey Data      

 

 

 

 

 

 

“The Prep Work” 

 

4  Read Parameters Window 

 

4.1 Survey Tab 

4.1.1 Perform Memory Test   

(Don’t exceed 100% of your computer’s RAM)  

4.1.2 Select Survey Mode (Vertical Reference) 

4.1.3 Set up/Select Matrix and Cloud Sections  

(Per your Scope of Work) 

4.1.4 Auto-Processing  

(Not applicable for this Outline) 

4.1.5 TPU  (Not applicable for this Outline) 



 

4.2 Corrections Tab 

4.2.1 Set or Select Tide 

4.2.2 Select Sound Velocity Profile(s) 

4.2.3 Set Dynamic Draft 

 

 

 

 

 

 

 

 

 

 

4.3 Devices Tab 

4.3.1 Verify/Modify Device Offsets 

4.3.2 Verify/Modify Patch Test Offsets 

4.3.3 Save Offsets to a  ‘BoatOffsets.ini’  file 

 

 

 

 

 

 

 

 

 

 

4.4 Processing Tab 

4.4.1 Select Heave Device 

4.4.2 Select additional Heave Options 

4.4.3 Select the Sonar ID for Geocoder 

4.4.4 Select the Sound Velocity Method 

4.4.5 Select a Presort Option 

 

 

 

 

 

 

 

5 Proceed to Stage 1 of the MBMAX64 Editor 



Stage 1 

6 Open the ‘Speed’ Window 

(Verify/ Modify the Speed of each file) 

7 Open the ‘Heave/Tide’ Window 

(Verify/ Modify the Heave and Tide of each file) 

8 Open the ‘HPR’ Window 

(Verify/ Modify the Heading, Pitch, and Roll of each file) 

9 Open the ‘SV’ Window 

(Verify/ Modify the Sonar Probe’s Speed of Sound for each file) 

 

10 Proceed to Stage 2 

“The Heart of the Beast” 

Stage 2 

11 Run Filters  (CTRL+F) 

11.1 Basic Tab 

11.1.1 Select a  Filter  (ONLY 1 !!) 

11.1.2 ‘Update Filter Preview’ 

Actions Tab 

11.1.3 Apply the Filter to ‘All’ or ‘Selected’ Files 

11.1.4 ‘Reset All’ Filters 

MBMAX64 Main Window 

11.1.5 ‘Update’ changes made by Filter  

 

11.1.6 Select the next Filter from the Basic Tab 

11.1.7 Repeat the above Steps until you have applied all 

the Filters you wish to apply from the Basic Tab   

(Again, 1 at a time.  This allows you to visualize how 

each Filter affects the data.) 

 

 

 

 

 

 

 

11.2 GPS Tab   (CTRL+F) 

11.2.1 Select a  Filter  (ONLY 1 !!) 

11.2.2 ‘Update Filter Preview’ 

Actions Tab 

11.2.3 Apply the Filter to ‘All’ or ‘Selected’ Files 

11.2.4 ‘Reset All’ Filters 

MBMAX64 Main Window 

11.2.5 ‘Update’ changes made by Filter  



 

11.2.6 Select the next Filter from the GPS Tab 

11.2.7 Repeat the above Steps until you have applied all the Filters you wish to apply   

(Again, 1 at a time.  This allows you to visualize how each Filter affects the data.) 

 

Important NOTE:  In the Sweep Tab, each of its Filters may need to be run thru several times.  Each time 

the Main Window is updated, the Filter reruns with the current selection and may find additional ‘bad’ 

points after extraneous points have been removed.  5 or more times may be common.  Pay close 

attention to the following order of Steps. 

 

11.3 Sweep Tab   

11.3.1 Select a Filter  (ONLY 1 !!) 

11.3.2 ‘Update Filter Preview’ 

Actions Tab 

11.3.3 Apply the Filter to ‘All’ or ‘Selected’ Files 

MBMAX64 Main Window 

11.3.4 ‘Update’ changes made by Filter  

11.3.5 If additional Yellow X’s appear on Main Window, 

repeat the Actions Tab. 

11.3.6 When NO additional Yellow Xs appear on the 

Main Window, go to next Step. 

 

Actions Tab 

11.3.7 ‘Reset All’ Filters 

 

11.3.8 Select the next Filter to be used from the Sweep Tab 

11.3.9 Repeat the above Steps until you have applied all the Filters you wish to apply   

(Again, 1 at a time.  This allows you to visualize how each Filter affects the data.) 

 

Important NOTE:  The Matrix Tab and its Filters can ONLY be used if you have the proper Tide, Sound 

Velocity Cast, Device Offsets, and Patch Test information entered.  This is due to the fact that the Matrix 

Filter is performing the filtering on overlapping files, and not individual files, like the Filters above. 

 

11.4 Matrix Tab 

11.4.1 Select Vertical Option 

11.4.2 Enable Above, Below, or Both 

11.4.3 Select Vertical Tolerance  

(2 Sigma = 95% Confidence) 

(4 Sigma = 99.994% Confidence) 

(Set Limit) 

Actions Tab 

11.4.4 Apply the Filter to ‘All’ or ‘Selected’ Files 



11.4.5 ‘Reset All’ Filters  

MBMAX64 Main Window 

11.4.6 ‘Update’ changes made by Filter  

11.4.7 Select the next Vertical Tolerance to be used from the Matrix Tab 

11.4.8 Repeat the above Steps until you have applied all the Vertical Tolerances that you wish to 

apply from the Matrix Tab   

 

NOTE:  Dependent upon how ‘clean’ your initial raw data is, using the Filters can potentially remove  

80 – 90+ % of your unwanted, incorrect data, making your Manual Editing a much easier task. 

 

12  Manual Editing 

Using the Manual editing Tools  (Lasso, Block, Line, Eraser, etc.) : 

12.1 Sweep 1 and 2 Windows 

Edit remaining spikes from individual files 

12.2 Cloud Sections  -  Edit and Mark as  ‘Checked’ 

12.3 Profile Window  -  Edit and Mark as  ‘Checked’ 

 

 

13 When ALL Cloud Sections and/or Profiles have been ‘Checked’ (verifying that ONLY ‘Good’ data points 

remain), you are ready to Save your data. 

 

 



      “The Finish Line” 

 

14 Save Files 

 

 

 

14.1 Save to HS2 format     

14.2 Save to HS2x format   

NOTE:  Saving to these ‘Edited’ formats 

will allow you to re-Edit and Modify any 

Offsets, bad SV Profiles, incorrect Tides, 

incorrect Patch Test values, etc. ) 

 

14.3 Save to XYZ 

14.3.1 ‘Save All Points’  data set 

(Ability to create detailed 

subsets from it) 

14.3.2 Save  ‘One Point per Cell’  

data sets 

 

 

14.3.2.1 Save with different Cell Sizes   

(Modify the Cell Size in the Read Parameters Window   ) 

 

14.3.2.2 Save with different Z-value Selection (Change the  ‘MTX Selection’) 

Examples of Selections:  1x1 Median, 1x1 Average, 1x1 Minimum, 1x1 Maximum 

              3x3 Median, 3x3 Average, 3x3 Minimum, 3x3 Maximum 

              5x5 Median, 5x5 Average, 5x5 Minimum, 5x5 Maximum, etc. 

 

14.3.2.3 Save data from  ‘Save All Files’  or  ‘Save Selected Files’ 

14.3.2.4 Name the File by its contents 

 

Example:   Boat Name_Jobsite_Date_Cell Size_Z-value.XYZ 

      MV Simpson_St Louis Harbor_11112014_1x1_Median.XYZ 

 

14.4 Save to other formats as needed 



 

 

 

Visual Guide to Hardware 
Configuration 
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